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1. Introduction

1.1 Operating Environment

1.1.1 Operating systems

Windows 2000, Windows XP or Windows Vista

1.1.2 Hardware requirements

CPU: Pentium 133 or better
Memory: 64Mbytes or more
Disk space: 30Mbytes or more

1.2 Functions and Features

With PEP Designer, user can design the own operating menu and function screen for the
ParameterEntry Panel (PEP) products. Featuresof PEP Designer include:

Various function items, such as menusyalue items, action items, and lists.

Hierarchical menu design supports 6 levelof menu and up to 10 menus for each level
Hints for each menu items and can be shown on the screen if required.

Design entry formatted with Unicode providethe capability of multilingual display on
the panel.

Unicode design for PEP designer provides the multilingual operation with a single
package.

Offline and online simulations accelerates design progress by saving the time for
elaborated design downloads.

Special character-input tool can store commonlused special symbols for future use.
Configurable display font at design time for the panel.

Multiple startup pages (graphics).

Menu import and export.

Flexible program editing functions acceleratedesign progress, including copy, paste,
delete, and scroll up and down.

Search function for searching data in the regter and strings. Can cal out and display the
corresponding design section of matched iterim the window with single click to the
matched list.

Alarms function with up to 64 alarm disply pages and each pagecan define up to 3
dynamic data.



2. Examples of Operations

2.1 Operating Window

There are four parts in the opeating window: Menu Bar, Toolbar, Project Tree, and Status Bar

as shown below.

Menu Bar

FEFLY

-

| % B i

File Edit Project Tools Options Hel

=Y

B

= Screen Saver
.-l Configuration

----- Ef Main Menu
i Alarms
Startup Screen

Project Tree - Start

Tool Bar |

Menu

Status Bar

7 —

Modified | | i

A

Tool Bar:

Project Tree:

Status Bar:

Menu Bar:

The menu bar provides access tall the functions of PEP Designer,
including the following six categories: File, Edit, Project, Tool,
Options, and Help..

The tool bar provides quick launch in iconic display to the
commonly used functions in PEP Designer. By clicking on the
respective icon, can directly lainch to the selected function.

The project tree categorize the wble project into six top nodes:
Device Info, Main Menu, Alarms, Startup Screen, Screen Saver,
and Configuration.

The status bar displays the present menu item and project
modification status. When the message Modified” appears on the
leftmost frame, the selected pra@jct has been modified but not yet
saved.
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2.2 Contents of Example

The following example illustrates how to plana project with the hierarchical menu and
actions for the room appliance control. The t@ common features in room control, lights and
air-conditioner, will be discussed in this exanple. First, we will divide the space into two
areas: bedroom and bathroom, bbtof which are equipped witHights. The bedroom lights are
equipped with dimming function, while the batho lights only withthe on/off function. The

air-conditioner is only equippé in the room with the set temperature and set fan speed
functions. After editing all menus and functionsthe entire operating process can be expressed

in the tree diagram below:

=

Main Menu

—
—
=]
—
—

The air-con Control

The lights Control

ra
=)
=)

(11) On/Off

Theroomlight | 2(0.0) The bathroom light [2(01) | Temperature Settings [2(10) | Speed Settings

[5%)

(100

[5%)

(1.1.0)

Brightness Adjustment | 3(000) | On/Off [3(00.1) | On/Off |3(010) | Setthe temperature Set the speed

Adjust the brightness | 4(0.0.0.0)

¢ There is a set of numbers inside parentheses next to each item. The sequence of these
numbers is 0, 1, 2, 3 and so on. The number on the leftmost indicates the level to
facilitate users to plan a project and will not be displayed in PEP. The numbers
within the parentheses, represent the level and item locations of the menu as shown
below.

Lights Control (0): Menu 0 on Level 0
Air-con Control (1): Menu 1 on Level 0.
Room Lights (0.0): Menu 0 on Level 1, i.e. one level below Menu 0 on Level 0.
Bathroom Lights (0.1): Menu 1 on Level 1;i.e. one level below Menu 0 on Level 0.
Set the Temperature (1.0.0): Menu 0, one level below Menu0 on the level below Menul
on Level 0.
Set the Speed (1.1.0): Menu 0, one level below Menu1 on the level below Menul
on Level 0.
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€ If you want to adjust the brightness of the room lights, adjust through the following
path (0.0.0.0).
—) Lights Control(0) Room Lights(0) X Brightness Adjustment() X Adjust
Brightness(0)

If you want to set the fan speed of the room air-con, adjust through the following
path (1.1.0).
> Air-con Control (1) K Speed Settings (1) X Set the Speed ()

2.3 Add Menu

Menu acts as a function button. As PEP Designerprovides the hierarchial menu architecture,
user can systemically categorize operatingfunctions by function aml by application at
different levels. You can also freely plan and design the categories and names of menus and
add hint to the menus.

Step 1: Double-click left mouse button at thd icon to start up PEP Designer.

Step 2:  After opening PEP Designer, a blank operating window will be opened. Select

[File] >[New] from the menu bar withthe mouse or click on icon EJ on the

toolbar or press the [Ctrl] + [N] keys to open a new file as shown below.

PEPD == T s
File JEdit Project Tools Options Help
B rdew Ctrl+MN

= e L= o ey

B Exit Alt+Fa

$¢ The Device Info. window will pop up as shown below. The Device Name item
represents the parameter entry device to be used in this project. You can input
descriptions for this project in the Descriptions item. These descriptions will be
displayed in the Open file dialog window which can facilitate the identifying and
selecting among the different project files.
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[ EA reeD == == ]

File Edit Project Tools Options Help
- T aR E3%SOHLY XKL+ FFwa5H |

—Project

-
EA Device Infornation L o o |
Device Mame:
[BPEP] 128764 Cled Display -]

Description:

| -

#¢ You can add description to this program in the Description field. Otherwise, press

the button and the project tree nodes in the red frame below will be

generated automatically. These include the Device Info, Main menu, Alarms, Startup
Screen, Screen Saver and Configuration menus. Now, you can begin planning and
setting up the project contents.

Ef PEFD = | =] |
File Edit Project Tools Options Help

B -] s BFRER BN S@EHY XkLe s FFragm |

—Project

[l Device Info.

tartup Screen
4 Screen Saver
Lol Configuration

Modified |

[
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Step 3: Select Main menu on the screen withthe mouse. Then select [Edit}> [Add Menu]
from the menu bar. You may also simplyright-click the item to call out the pop-up
menu and select [Add Menu] as shown below.

EA pePD = T 5

FiIeI Edit IPrOject Tools Options Help

Fadanvens ||

Add Action .

& £

Ctrl+F

Modified | o &

The Add Menu window will be shown as below.

HEd PEPD =|E=] =
File Edit Project Tools Options Help

D -] ek B3 AR SGE Yy XKL + EFPSEH |

—Project
EA Add Menu |3
String: ||
L Confia Description: -

W OK I x Cancell

Modified | [0 [ &

W

2 “String” refers to the title of the menu item. Text in the “Description” field is the hint

for this menu.
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Step 4:  Enter the title of the firstfunction menu “The Lights Control” in the String field and
enter the functions or explaations of this menu in theDescription field as shown

below.

II: rﬂ Add Menu -
String: IThe lights Control
Description: i

' OK I X cancel |

Step 5:  After inputting data toboth fields, press the L % | putton to add the Lights

Control menu to the project, and this Ad Menu will appear under the Main menu
node as shown below.
| @ perD =R EETRS

File Edit Project Tools Options Help

BB -] e E4 4 SQ@Ey Xk + FTFHg 5 |
—Project

.. = = 2 T £

= 8=

1 B The lights Control
AlarTns

Startup Screen

4 Screen Saver

= Configuration

Modified | [o A
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Step 6: Repeat Step 5 to add the second functiomenu Air-con Control to the
shown below.

project as

Ef PEPD o = B

File Edit Project Tools Options Help
De-@] ' BTk B3R SAEHY XKL+ EFPHam |

—Project

Ef The lights Control
Ef The air-con Control

Startup Screen
-[Ed Screen Saver
% Configuration

Modified | [0 [ S

% After creating the two main function menus of the project, continue creating the

internal space and function menus for the project.

Step 7: Select Lights control on the screenwith the mouse. Then select [Edit}> [Add Menu]
from the menu bar. You may also simplyright-click the item to call out the pop-up
menu and select [Add Menu]. Now you can create the Room lights and the

Bathroom lights menus under the Lights control menu as shown below.

EA cerD [E=YEE =

File Edit Project Tools Options Help

DB -E s TR (B %N SRL Y XKL + TPy H
—Project
i_ Device Info.

Sl The lights Control

:-Ef The room light

€ alr-Con Contro
-y Alarms

& Startup Screen

- Screen Saver

“-=rd Configuration

Modified | 1 [0 A
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Step 8: Select the Room lights on the screenwith the mouse. Then select [Edit}>[Add

Menu] from the menu bar. You may also simgy right-click the item to call out the
pop-up menu and select [Add Menul. N@, you can create the Brightness

Adjustment menu under the Room lights menu as shown below.
rﬂ PEPD

File Edit Project Tools

S| E | ]

Options Help

DS ' t B m B it sBEGy XL e + T Py H |

Froject

& Device Info.

=-BF Main Menu
L2 The

i} Alarms

--J&& Startup Screen
--Ed Screen Sawver
% Configuration

NModified | 2 0.0

Step 9: Select the Air-con Control on the screenwith the mouse. Then select [Edit}> [Add

Menu] from the menu bar. You may also simgy right-click the item to call out the
pop-up menu and select [Add Menu]. Now, youcan create the Temperature settings

and Speed Settings menus under the Air-con Control menu as shown below.
D

File Edit Project Tools

m@g

Options Help
D -E{ BTFER (B9 %SGy Xk o NP5 8 |
Project
- & Device Info.
=-E Main Menu
=-E The lights Control
{ =-Ef The room light
.. Brightness Adjustment

T COCrTr i

— =L
EIE The air-con Control

e Bl Temperature Settings
--E] Speed Settings
Alarms

& Startup Screen

B Screen Saver

%} Configuration

Modified | 1

&
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After creating the two main function menusand their sub-menus, these menus will be

displayed under the Main menu as shown below.
[ Ed rerD == T s

File Edit Project Tools Options Help

DE-E] s Rk B4 *%SOQHY XKL+ EF%gH |
—Project
e S s L L

[ oo

=-Ef The lights Control

: E The room light

+.. Bl Brightness Adjustment

EE The air-con Control

------ Ef Temperature Settings

i | s
- Startup Screen
- i Screen Saver

-5 Configuration

Modified | [o

N

2.4 Set Action

After creating all menus in the Main menu, youmay continue with the controls: Light Switch
and Air-con Switch. As a switch is used to turn the power ON and OFF, the functions in the
Action item can fulfill this demand. Therefore,you can set the switchactions by selecting
[Add Action].

Step 1: Select the Room Lights on the screenwith the mouse. Then select [Edit}>[Add
Action] from the menu bar. You may also simply right-click the item to call out the
pop-up menu and select [Add Action] as shown below.

8 rerD [E=N =

File Edit Project Tools Options Help

DS -@ Rl B E% S BEHy XL + TP 8 |

—Project

o~ & Device Info.
=-Ef Main Menu

EIE be

El 1=fl The room light
e % Cut Ctrl+
-El The bathroom Copy Ctri+C

=-Bf The air-con Contry 52,
B Temperature g 25
. Speed Settings E, Ctrl+
i) Alarms =
: Startup Screen %‘ .
3 Screen Saver - -
----- %l Configuration j J
L1
Ed creen
" Edit
> Delete Del
e Delete Leaf Ctrl+Del
¥, Delete Node
Modified | [2 PR—— >
e ———————————— ILVE _—

F Mowve Down

# Import Menu _..
BPF Export Menu ...

Page12/81



The [Add Action] window will pop up as shown below.

Ed rePD =l=] <
Fil Ediy”
1= " EA Add Action =S s
| B = g B
Project Action Type: IToggIe State ;I
=B Ma String (ON): ||
=B
B String (OFF) : |
=R
Description:
..... o Al 4 L4
-EE St
>4 Reference Mo.:
..... OTE Col

W OK I x Cancell

hModified 2

% In the Action Type item, select Toggle State for Light Switch. You can enter the action
strings according to the information in the following example. According to the
example, when the action is activated, “Y0” will be the reference number
corresponding to the PLC, and the actions On and Off will be displayed alternately.

|::> | EA Edit Action [E=REE
Action Type: I'I'oggle State LI
String (ON): ITurn on the light
String (OFF) : ITurn off the light
Description:
4 k -

Reference Mo.: [yY0

W 0K I x Cancell
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Step 2: After complete the input data, press the button to add the Turn on the

Light action to the Room Lights menu as shown below.
| Ed PEPD e e

File Edit Project Tools Options Help
| DE-E] t Rt B 5% SAHvy XKk + ErP%gH |
—Project

- & Device Info.
&- E Main Menu

EI E The air-con Control
------ E Temperature Settings
------ .5} Speed Settings
i Alarms
Startup Screen

-] SCreen Sawver
-4 Configuration

Modified | |2 [0.0 =

% If you want to modify the action, select the action with the mouse and select
[Edit]>[Edit] from the menu bar. You may also simply double-click the item to call
out the Edit Action function and modify the action. After modifying the action, press

e button to confirm modifications.

Step 3: Repeat Steps 1 and 2 to add actions to #hBathroom lights andthe Air-con Control.
After adding functions to these actions, #y will be displayed under the respective
items as shown below.

G == =
File Edit Project Tools Options Help
D -E] R R (BN S®EH Y X kL o T T o |
[ Project

-~ & Device Info.

=-E Main Menu

=8 E The lights Control

. =-Ef The room light

I E Elrlghtrless F\d]ustmerlt

A== Turn on the air-con

----- P Alarms

--E& Startup Screen
--E& Screen Sawver
----- i Configuration

Modified | 1 1 )

¢ In this example, the reference numbers corresponding to the PLC are: “Y0” for The
Room lights (On/Off), “Y1” for The Bathroom lights (On/Off), and “Y2” for The
Air-con Switch. As shown below.
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@ eerD B NETR
File Edit Project Tools Options Help
B -t ek B34 5Q@H Yy XKL+ Fruam |
—Project
-~ & Device Info.
Xgvioin venu

=-E The lights Control
-5 The room light
B} Brightness Adjustment
-#= Turn on the light

Reference No.: YO

= 2 _Turn on the light Reference No.: Y1

& E The air-con Control

B Temperature Settings
[ Speed Settings

== Turn on the air-con

-y alarms

Startup Screen

: Screen Saver

% configuration

Reference No.: Y2

Modified | [0 &

2.5 Set Value

There are two operations concerning the Aicon: Temperature Settings and Fan Speed
Settings. Let us begin with Temperature settingsAs temperature is set by means of value, the
Add Value function can fulfill this demand. Therefore, we can achieve Temperature Settings

with the Add Value function.

Step 1: Select Temperature Settings on the s@en with the mouse. Then select [EditP» [Add
Value]. You may also right-c lick the item to call out the pop-up menu and select
[Add Value] as shown below.

A Cut Ctrl+x
By Copy Ctrl+C

[ EA perD

File Edit Project Tools Optits

EERE Y

—Project

- § Device Info.

=-Ef Main Menu

Eg The lights Control

i =B The room light

EJ erightness adjustn

Turn on the light y

=] g The bathroom light - Mowve Down
------ -l— Turn on the Ilght

S —

Z2ETEES 2R

» F?X(ﬂnnj—@ e

T Import Menu .

Ten]perature Settings E EEERlEEy =

=l
L Turn on the air-con

----- 3 Alarms

Startup Screen

2 Screen Saver

i Configuration

Modified | [2 [10 2
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The Add Value window will pop up as shown below.
rn PEPD (== g2 ]
File Edit Project Tools Options Help

DS -@ e B S% S By XL+ TP 8 |
[Ca EA ~Add value S|

i Devig

E‘E Main String: ||
= T
== Description: -

Reference Mo.: [~ signed

Max. Decimal Point: Ig vl
’ Unit: |

o OK I x Cancell

[~ Read Only

Modified | [2 [1o 4

e

¢ “String” refers to the title of the value item. Assign a register in “Reference No.” to
store the value input by users. “Max.” and “Min.” represent the range of the value
restriction when input the value.

:> 'ﬂ Edit Value | B

String: Set the temperature
Description: -

« 2 -
Reference MNo.: IRD I~ Signed
Mane. I4U Decimal Point: m
Min- [10 Unit: fc—
[ Read Only

W 0K I X cancel |

€ In this example, “R0” is the reference number corresponding to the PLC, i.e. the
register assigned to save the value for Set the Temperature. The Maximum and
Minimum values are 40 and 10 respectively. The temperature unit is °C.
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Step 2:  After complete the input, press the button to add the Set the Temperature

value item under the Temperature Settings menu as shown below.
md cerD P TR ==

File Edit Project Tools Options Help

| B - R NN SAREH X+ + R H |
[ Project

- & Device Info.

=-E Main Menu

=& The lights Control

-Bf The room light

‘Ef Brightness Adjustment
Turn on the light

! Elg The bathroom light

b Turn on the light
=y

EI E Temperature Settings

-123 Set the temperature
Speed Settings

i ®E Turn on the air-con
- Alarms
- Startup Screen
- Screen Sawver
—-&rl Configuration

Modified | |2 1.0

2.6 Set List

There are five choices for the Fan Speed Setings item in the Air-con Control menu: High,
Medium, Low, Mild, and Auto. The choices for the Brightness Adjustment item in the Room
Lights menu include High, Medium, and Low. As every function in the list must contain a
corresponding value, when you select an choicghe corresponding value of the choice will be
written in the PLC register as desired. Therebre, we can implement the Fan Speed Settings
and Brightness Adjustment vith the Add List function.

N

Step 1: Select Speed Settings on the screen with the mouse. Then select [Editt[Add List].
You may also right-click the item to call out the pop-up menu and select [Add List]
as shown below.

4 Cut Ctrl+X

Bz Copy Ctrl+C
B packa Aftar

Ed PEPD B Lo o S|

File Edit Project Tools | B Add Menu .
122 add value ...

| B~ & || & B {a aggacon v X It & o S P |
o I —

i Device Info. T

=-Ef Main Menu Egd Add Startup Scre
=-Bf The lights Control| .~ Edit

- =Bl The room light ¢ pelete Del
BT Brightness ;

Turn on the
= g The bathroom
: L.#E Turn on the € Move Up
B E The air-con Contr{ % MMove Down
= E Temperature g

[ amm

E Import Menu .

----- con

Startup Screen
2 1 Screen Saver
----- =i Configuration

Modified | [2 11

Page17/81



Step 2:  After complete the input data, press the button to add the Set the Speed

list to the Speed Settings menu as shown below
rﬂ PEPD

File Edit Project Tools

[
Options Help

-~ § Device Info.

=-Ef Main Menu

B The lights Control

=-Ef The room light

E Brightness Adjustment
L# Turn on the light

B E‘_ The bathroom light

--#% Turn on the light
EI E‘_ The air-con Control

DE~-d] i Bk BN SAEvXkLes e T FPaaH |
—Project

EI E Temperature Settings

LIre

E?E

= Set the 5 eed
L.#% Turn on the air-con
-} Alarms

- Startup Screen

- Screen Saver

- %Ed Configuration

;& Device Info.
=-E Main Menu
= g The lights Control

Modified | [2 [11 A
Step 3: Repeat Steps 1 and 2 to add the AdjusBrightness list to the Brightness Adjustment
menu as shown below.
[ @ cecD | = |
File Edit Project Tools Options Help
D-E s R M SRE Xk + TPy |
—Praoject

|=# Brightness Adjustment
i= Adjust the brightness

== Turn on the light

=} E The bathroom light

-~ Turn on the light
&- E‘_ The air-con Control

EI E Temperature Settings
: -123 Set the temperature
EI E Speed Settings
i = Setthe speed
-~#% Turn on the air-con
----- & alarms
- Startup Screen
{d Screen Saver
----- “¢ll Configuration

Modified | [3 [0.0.0
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€ In this example, the register R1 is assigned to list item - “Set the Speed”, while the

register R2 is assigned to list item - “Adjust Brightness”.
| @ eeeD =N EETR s

File Edit Project Tools Options Help

| BE-H| ek E3ASAEH Yy XKLy + EFRgH |

—Project

¢ Device Info.

=B

= E The lights Control
! E‘_ The room Ilght

W= hd]ust the hrlghtness
. EE T UTT O the g
= E‘_ The bathroom light
L..#% Turn on the light
& E The air-con Control
EI '@‘_ Temperature Settings
: 122 Set the temperature

----- i slarms
-l Startup Screen
--Ed Screen Saver
..... “fi Configuration

Reference No: R2

Reference No: R1

Modified | o |

2.7 Simulation and Downloading of Designs

After creating the user menus,you may want to validate if tley are consistent with the
planning. Run the On-line Simulation to testthese menus. With the On-line Simulation, you
can save labor and time from loading menus taun the test on the operating device every time
after editing a function. After finished the sinulation test, only wheneverything is verified
and validated, menus design is requéd to download to PEP device.

2.7.1 On-line Simulation

Similar to the Off-line Simulation, which runs the simulation on the PC, the only difference
between the offline and online simulation is &t the former does not connect to the PLC,
while the latter connects to the PLC viathe communication port on the PC running the
simulation.
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Step 1:  Select [Project]>[On-line Simulation] from the menu bar with the mouse. You may

also click the E icon on the toolbar or press the [F10] function key on the

keyboard to directly launch to th®©n-line Simulation as shown below.

| & rerD = |
File Editl ProjectITools Options  Help
| @ s "= Compile_ HELELLE AT EREY I 2
e Off-line Simulation F9
roje
o 7 Delbi = £ -
=R Main Me

EI Ef The lights Control
B E The room light
=-Ef Brightness Adjustment
‘= Adjust the brightness
e ®E Turn on the light
B- E The bathroom light
: - #% Turn on the light
E The air-con Control
EI E Temperature Settings
i -123 Set the temperature
= E Speed Settings
: --1= Set the speed
L. Turn on the air-con
----- & Alarms
=4 Startup Screen

----- TE Configuration

Modified | [o &

Step 2: The “Compile Result” window will pop up. The information in the window
includes Code Size Usage and Output File as shown below.

(A oero (=[=1] = J]

File Edit Project Tools Options Help

DS - s R ek B %% 8Ey XL ® s+ T ag 5 |

—Project
-2 Devigt i =X
: Compile Result
=-Ef Main E4 B
EI E L
) | Code Size Usage: 3892 Bytes used / 131072 Bytes available
o | Output file : C:\Program Files\Fatek\Pepd\FPepd.mda
i 2%
ted |

‘..# Turn on the air-con
- Alarms

-2 Startup Screen
il Screen Sawver
%l Configuration

Modified | [o

[
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Step 3:  After verify the compile result is OK, press the button and the Setup Port

Parameter window will pop up as shown below.

PEPD = 2 |
File Edit Project Tools Options Help
Ds~-& B L i e NN
Project
-~ & Device Infoy T
- E_— T B Setup Port Parameter
EI E The ligh Baud Rate: |Ei] -
Com Port: [COM4 |
= E The air-]
=8 ETTem
: RECN:
EI '@‘_ Spee Start Exit
5
b B Turn
— i Alarms |

- Startup Screen
- Screen Saver
-%F] Configuration

Modified [v]

Step 4:  After setting up the Baud Rate and Com Port, press the_5® | putton. The

[On-line Simulation] screen will pop up as shown below.

rﬂ PEPD | = = |
File Edit Project Tools Options Help
beE-H E -=l=-.. 3 T EFw B S
Project
& Device Info. . -
; Simulation Screen &I

=B Main Menu
Elé‘_ The lights Contra
: =B The room ligh
Elg Brightness
= Adjust
w5 Turn on th
=-EF The bathroom
: “.# Turn on th
B E The air-con Contf
=- E Temperature
. ..123 Set the tef
EI E Speed Setting
= Set the spi
Turn on the a

2 Startup Screen
. Screen Saver L
----- “rd Configuration

Modified [v]

2.7.2 Download Design to PEP

After validating the function ofdesign with the simulation, you may download the design to
PEP. Before download design to PEP, you must first switch PEP device into system menu

mode.
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Step 1: At PEP device side: Press the ESC key on the PEP device for at least 6 seconds to

enter the System Menu as shown belowSelect [Load User Menu] and press the
key. The screen will show “Load User Menu?” and “ [J{3Y Ol Qe ®e]Islilgan]’.

If you want to load user menus, press thm key. The screen will show

“Waiting for connection...” and ‘Y@ e \elelgy". This means the PEP device
is waiting for PEP Designer to transfer the design.

Step 2: At PC side: Select [Tool] >[Download Menu Data] from the menu bar with the
mouse as shown below.

Ef PEFD ‘ | S e
File Edit Project]l Tools | Options Help
B = |k ™) Download Menu Data ..
- Drownload Firmware _.
Project
38 Character Map Tool |

# Device Info.
&8
=& The lights Control
= E‘_ The room light
EI g Brlghtness Adjustment
1= Adjust the brightness
L& Turn on the light

=B The bathroom light
; i.# Turn on the light
EI E The air-con Control

EI E‘_ Temperature Settings

. i.122 Set the temperature

EI E‘_ Speed Settings

: 1= Set the speed

iew®25 Turn on the air-con

----- 3 Alarms
- Startup Screen
. Screen Saver
..... 41 Configuration

Modified [v]
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The “Download Menu” window will pop up as shown below.

EA PEPD

=|=] = |

File Edit Project

Tools Options Help

DE-H] ' BrRR ES% SQ@EHY XKL s S FegH |

—Project

HEHA Download Menu

EE‘_ Main Men

Baud Rate: IS&UU vI

Com Port: |COM4

File Name:

IC:\Prog ram Files\Fatek\Pepd\Pepd.mda

4 Screen Saver
----- 8 Configuration

Modified |

[0

Step 3:

After setting the Baud Rate and Port and the compiled design filename, press the

__s@t | putton to download design to PEP device as shown below.

Ed FePD

= |=1] =& ||

File Edit Project

Tools Options Help

DS -]t ek BE5A%ASBE Y XkiLs + EPSHH |

—Project

=B Main Men

HEHA Download Menu

Baud Rate: IQ&UU vI

Com Port: IC[}M4

File Name:

IC:\F’rog ram Files\Fatek\Pepd\FPepd.mda

WWrite packets 23

A4 Screen Saver
----- s Configuration

Modified |

[o
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% When there is a communication connection error, the “Communication Error!”
message box as shown below will pop up.

e =[E=] & ]
File Edit Project Tools Options Help

B -d|| i mraba B3RS Ly XLy + P |
—Project

- § Dewvice Infog )
. EA Download Menu =@ 5=
=-E Main Menu —

EI '@‘_ The ligh Eaut[n Communication Error e | ]
il E Con ,'-‘ ;
Co\P Communication Time Out Error _I
Froceed to retry ?
E Tem| | |
S |
Get Station Mumber.. e
.
i Startup Screen

-l SCreen Saver
ﬂ Configuration
Modified | [o A

X When design is completely downloaded to PEP, the message “Download finished!”

will display in the status bar of the Download Menu window as shown below.
(@ perD [=[=1] = ]

File Edit Project Tools Options Help

s -] ek B ASGEH Yy X kL + EPSEH |

—Project

- & Device Infoy
e Ef Download Menu o o |

=-Ef Main Menu

= E The ligh Baud Rate: [9600 -]
Com Port: [cOM4 ~|

File Name:

IC:\F’rogram Files\Fatek\Pepd\Pepd.mda _|

I Download finished ! I |

----- Z Startup Screen
Screen Saver
----- “rd Configuration

Modified | [0

N

Step 4: Lastly, press any key on PEP to return to the System Menu screen. Select [Run User

Menu] and press the key to let PEP back to normal work.
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3. Operations in Detail

3.1 File

Select File with the mouse from the menu baor press [Alt] + [F] keys on the keyboard. The
File pull-down menu as shown below will appear.
'EPD l= [ = |

File Edit Project Toold Options Help
ENew.. N plerm B [B SG% S®HY Xk * + 5 Fag5 |

= Open Ctrl+0O
W save Ctrl+S
F] Exit Alt+F4

N

3.1.1 Create a File (New)

Select [File] 2>[New] with the mouse from the pull-down menu, or click therrom the

toolbar, or press the [Ctrl] + [N] keys on the keyboard to open a new file. Items in the file as
shown in the red frame below, including Maimenu, Alarms, Startup Screen, Screen Saver,

and Configuration, will be geneated automatically. Now, you canstart planning the desired
screens and settings.
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EA PEPD =N TR s

File Edit Project Tools Options Help

-t BaTfak|( R IR SAEYX KLY+ EFPugH |

—Project

Startup Screen
Screen Sawver
-#rl Configuration

Modified |

A

3.1.2 Open a File (Open)

Select [File] 2[Open] with the mouse from the menu baor press the [Ctrl] + [O] keys on the
keyboard to open an existing file.

e S

Pl (I I | PEF Designer-sample LI = =k E-
T =L EEd=E =1 il
o Efsample.pep
bt L= ] i
||
am
TC-WANG
HiE
A
]
s
wEeEy: | | EEEe
| #2488 T): [PEP files (* pepy =] I B |
Description: -
o ‘ [

$¢ The file extension of project file of PEP Designer is .pep.
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EA PEPD =N TR s

File Edit Project Tools Options Help

-t BaTak| (R IR SAEYX KLY+ EFPugH |

—Project

Startup Screen
Screen Sawver
-#rl Configuration

Modified |

A

3.1.2 Open a File (Open)

Select [File] 2[Open] with the mouse from the menu baor press the [Ctrl] + [O] keys on the
keyboard to open an existing file.

e S

Pl (I I | PEF Designer-sample LI = =k E-
T =L EEd=E =1 il
o Efsample.pep
bt L= ] i
||
am
TC-WANG
HiE
A
]
s
wEeEy: | | EEEe
| #2488 T): [PEP files (* pepy =] I B |
Description: -
o ‘ [

$¢ The file extension of project file of PEP Designer is .pep.
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“ul
You may also click the pull-down menu next to theE icon to open a file that has been

edited previously.

[ EA PEPD - C\Users\admin\Desktop\PEP Designer\sample pep L e S

File _Edit _Project Tools _Optigns _Helo -
S]] + mF 2R |E % S@EY XL+ + %y 5 |

—Projfd (5 Open ... Ctrl+O

1 ChUsershadminyDesktophPEP Designerysample.pep

2 ChUsers\adminyDesktop\PEP Designen g3 #Is2E8.pep

3 CAUsersyadminyDesktop\PEP Designen, 23 FIs2AE(E).pep
4 ChUsershadminyDesktophPEF Designenf#2= . pep

5 CAUsersyadminyDesktop\PEP Designen g Fl.pep

6 ChUsersyadminyDesktop\PEP DesignenZE#SHE . pep

7 ChUsershadminyDesktoph\PEP Designen == E=5.pep

N

3.1.3 Save a file (Save)

After editing an existing file, if you want to save the changes, select [Filep>[Save] from the

menu bar, or click the E on the toolbar, or press the [Cti] + [S] keys on the keyboard to

save the file in the same filename and location.

i Ef PEPD - C\Usershadmin\Desktop\PEFP Designer\sample.pep Elﬁlg
File Edit Project Tools Options Help

DS - el RS G %N SBEY XKL+ TP H |
[ Project

& Device Info.

=Rl Main Menuj

-Ef The lights Control

=-Ef The air-con Control

O Alarms

: Startup Screen

: i Screen Saver

‘.9 Configuration

N

| Modified | o [

€ Modified: This means the file has been modified but not yet saved.
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3.1.4 Save as Another File (Save As)

After editing a new file, you can only saveit as another file by selecting [File]>[Save As]
from the menu bar to save the new file in th designated folder. Ifyou want to change the
name of an existing file, you can select [File]>[Save As] from the menu bar to save the file
using a new file name (generated by the system).

[ E# PEPD - C\Users\admin\Desktop\PEP Designer\sample.pep |E|EIA.P
File
[ i == =]
—Pr EETFRL: I . PEF Designer-sample LI = £k Ef~
""" é = == EE=E =m Sl
B e,
T BT E ERAample pep
: |
S
Wi
YC-WANG
L
HiE
&
e,
HERE
mwEeme: [ ] )
TFIEERANT): IPEP files {*.pep) LI HriH I
Modified | [o >

% Attention! If you want to save an existing file in another file, you must give this file a
new name that does not appear in the folder where it is saved. Otherwise, this file
will replace the file having the same file name in the folder as shown below.

E# PEPD - C\Users\adminyDesktophPEP Designer\sample.pep

. =B Thelig
- =-E The air

= Startup Sc
Screen Sa
.=l Configurat

== = N
File Edit Project Tools Options Help
D - i BT ERE | R S% SO XL s TP H |
—Project
- & Dewice Infi
LE o ”9”1[“ e (ol

|

AN

O mom

File Existed,Over Write ?

Modified | [o
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3.1.5 Export a File (Export)

As some menus can be shared with other pregts, you can use the Expot function to export a
menu and its submenus to another file for futurese. When you need to use them, you can use

the Import function to import theelected menu file. Follow the steps below to export a menu
and its submenus.

Step 1:  Select the menu with the mouse as shown below.

i EA PEPD - Ch\Usershadmin\Desktop\PEP Designerisample. pep L o o B
File Edit Project Tools Options Help

DE-| ek B 5% SQEHY XKL+ w5 |

[ Project
- § Device Info.

Startup Screen
Screen Saver
Lol Configuration

Step 2: Select [File] >[Export] from the menu bar. The following window will pop up.
Select the folder where the menu is exportkand input the file name, and press the

FEE | button to export the selected menu.

e ==
pr— .
Ed BE iE-Eenali B R I . PEP Designer-sample ;I — cF Ex-
Filg T == Eu A m= e
i b - = .
| B e . mETsEanEE -
—Proje: N
= E
‘IL I
WC-WANG
ﬂs!_-‘_!'
==
[
—
s
AR FT A (M) T | e |
TEEREAM (T): |FEF tenu. files (* bpam) = _ Emm |
Description: -
« [

#< The extension of the menus exported is .bpm.
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3.1.6 Import

When the present project needs some menus tHadve been created, we can search them from
the folder where the exported menus are sted. If there are suitable menus, use the Import

function to import them in ordeto save time from re-creating them. Follow the steps below
to import the menus.

Step 1:  Select the destination of import with thenouse. As shown below, the destination is

Main menu.
i PEFD - Ch\Users\admin\Desktopy123 pep [ T |
File Edit Project Tools Options Help
IREN=

-l || R Rk R EERRSRN Y Xk + FEFugE |

—Project

tartup Screen
Screen Sawver
ol Configuration

Step 2: Select [File] 2[Import] from the menu bar. The following window will pop up.
Select the required file and press the Open button to import the selected file.

EEmiEstE

B E ay | | PEP Designsr-sampls -] = ¢ B

=1 =22 B8R F=E Fan

| R

:

R T || The lights Control bpm
AT
‘IL I
VC-WANG
EA..‘_!'
== hE
[~
S
s
AT A T (1) |The lights Control bpm 1 RAErEStE 00 |
THEFTEEHRY (T [PEF bdenn files (* bpm) =1 ] |

Description:

=

$¢ The extension of the files imported must be .bmp. Like the project file, users can add
descriptions to an export file
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Step 3:  After importing the menu, the menu and its submenus will be displayed under the
destination (Main menu) as shown below.

PEPD - C\Usershadmin\Desktop\123.pep =R
File Edit Project Tools Options Help

| BE-M|| s TR ES3HSBEHY XKLy + EPF25 8 |
—Project
i_ Device Info.

-BF
=-E The room light
{ =-Bf srightness Adjustment
LS Adjust the brightness
i Le®F Turn on the light
=-EF The bathroom light

L..# Turn on the light

----- Alarms
----- Startup Screen
----- Screen Saver
----- “f{ Configuration

3.2 Load and Edit Designs

PEP Designer shows screen planning in termsof tree structure. Each “menu”, “value”,
“action” and “list” is displayed hierarchically for users to clearly identify what they are in the
operations in order to check if the sorting andtructure of the entirgplanning are consistent
with the requirements.

3.2.1 Menu

The main function of menu is to categorize “valies", “actions” and “lists” into various levels
according to their applications and functions. This way, users can operate them instinctively.
The following example describes how the mendunction works in terms of temperature,
switch, and adjustment.

Step 1: Select the Main menu on the screen Wh the mouse. Then select [Edit}>[Add
Menu] from the menu bar, orright-click the item to call out the pop-up menu and
select [Add Menul].

Step 2:  When the [Add Menu] window pops up, enter Temperature settings in the String

field and press the button to add the Temperature settings menu to the

Main menu as shown below.
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- Add Menu [

String: Temperature Settings

Description: Used to set or adjust the temperature.| -

' OK I X cancel |

% String: The title of the added Menu.
Description: Hint text for the added Menu.

Step 3: Repeat Steps 1 and 2 toadd the “Switch Control” and “Size Adjustment” menu as
shown below.

PEPD [ T S|

File Edit Project Tools Options Help

DS -E| R ERE B G% SBEY XML+ Py 5 |

[ Project

B Temperature Settings
B Switch Control
Ef size Adjustment
ANTTTTS

Startup Screen
Screen Saver

Lol Configuration

nModified | o [

|

%€ Please note that each level can place 10 menus or functions at most. Also, a menu can
only mix with other menus or actions at same level. That is, if you want to add a
menu/action item at certain level, there should not already have the value or list
items in that level. The menu item can have an attached lower level while value,
action and list item is not (button level).

3.2.2 Value

The value item allows users to read or set the’LC register contents from PEP. Users can use
this function when designing actions involvingalue setup. We can use the above example to
illustrate this: Temperature Settings.
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Step 1:  Select Temperature Settings on the screewith the mouse. Then select [Edit}> [Add
Value] from the menu bar orright-click the item to call out the pop-up menu and
select [Add Valuel].

Step 2: When the [Edit Value] window pops up, enter the requirements and settings to
respective fields and press the button to add a value item to the Main
menu as shown below. Descriptions ofhe Edit Value window are as follows:

[ A Edit value (i |
String: |Set Value's example
Description: -
Reference No.: |Rg v Signed
Max. |32757 Decimal Point: m
Hin- [-32768 Unit: cr
[ Read Only
W OK | X cancel |
P String: Title of the value item

Description:
Reference Number:

Signed:

Maximum:
Minimum:
Decimal Point:
Read-only:
Unit:

Hint of the value item.

The reference number correspondingo the PLC register, either
16-bit (R, D) or 32-bit (DR, DD).

When the item is checked, values of the register is signed number
otherwise is non-signed number.

The upper limit of the value. No limit when blank.

The lower limit of the value. No limit when blank.

The decimal location of the displayed value.

Value can be displayed but cannot be modified or set.

Unit of the value, here is °C.

After completing these steps, the value item wilbe added to the Temperature settings menu

as shown below.
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E@g

Ed PEPD
File Edit Project Tools Options Help

DS - 4 R RE SR SBREY XL +» TP S |

[ Project
o~ & Device Info.

H B=B =il Temperature Settings

-128 Set Value's example
e SWILCh Contr ol

i L.E Size Adjustment
B Alarms

Startup Screen
+-[Ed Screen Saver

‘%] Configuration

N

Modified | 1 [o

3.2.3 Action

There are eight types of actions in PEP Designe. The “Switch Control” in this example is
only one of them. Users can use the Action @inction to design Toggle State, ON/OFF, Set
Value or Step Up/Down actions. In this secton, in addition to the Switch Control in the
example, we will further introduce to yowther action optionsn this function.

Step 1:  Select Switch Control on the screen. Then select [Edit]2>[Add Action] from the
menu bar, or right-click the item to call out thepop-up menu and select [Add

Action].

Step 2:  After selecting the required action fronthe pull-down menu of the Action Type
item in the [Add Action] window, press the button to add the selected

action to the Switch Control menu. The example is as follows.
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[ EA Add Action [E=R R

Action Type:  |Toggle State =]
ogagie e

String (ON): Set On
Set Off

String (OFF) : Momentary On
Momentary Off
Set Value i
Step Up

Description:  |>tep Down

4 »

Reference Mo.: I

W OK I x Cancell

& Options for actions include: Toggle State, Set On, Set Off, Momentary On,
Momentary Off, Set Value, Step Up, and Step Down as described below.

1. Toggle State: On and Off alternate actions

Add Action [E=R TR
Action Type: B
String (ON): |

String (OFF) : |

Description:

4 L

Reference Mo.: I

« 0K I x Cancell

RS String On:  When the corresponding status is @, the text to be displayed on
the menu.

String Off: When the corresponding status is Gf the text to be displayed on
the menu.

Description: Hint of action.
Reference No.: Contact number corresponding to the PLC.
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2. Set On: Set corresponding status to On.

4

Reference MNo.: I

W 0K I x Cancell

EA Add Action oo 0
Action Type: E
String : I
Description:

Description: Hint of this action.

X String : Title of the corresponding action.

Reference No.: Contact number corresponding to the PLC.

3. Set to Off: Set corresponding status to Off

4

Reference No.: I

" 0K I X Cancell

EA Add Action [E=EERS
Action Type: E
String : I
Description:

Description: Hint of this action.

X String: Title of the corresponding action.

Reference No.: Contactr number corresponding to the PLC.
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4. Mometary On: Set corresponding status to On whepressing and Off when releasing.

Add Action =
Action Type: Momentary On -
String : |
Description:

4 »

Reference Mo.: I

W OK I x Cancell

X String: Title of the corresponding action.
Description: Hint of this action.
Reference No.: Contact number corresponding to the PLC.

5. Mometary Off : Set corresponding status to Off whempressing and On when releasing.

Add Action [E= e
Action Type: Momentary Off =
String : I
Description:
4 3

Reference MNo.: I

o OK I x Cancell

X String: Title of the corresponding action
Description: Hint of this action.
Reference No.: Contact number corresponding to the PLC.
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6. Set Value: When pressing the key, the value inthe corresponding register increases by

one value.
[ B Add Action o] S
Action Type: =
String : I
Description:
o4 2
Reference MNo.: I S0
" Signed ' Unsigned
Set Value: I
" OK I x Cancell
P String: Title of the corresponding action.
Description: Hint of this action.

Reference Number:
16-bit (R, D) or 32-bit (DR, DD).

Set Value:

Signed:

otherwise unsigned.

The reference number correspondingo the PLC register, either

Value to be set when press this action
When the item is checked, values of the register are signed ;

7. Step Up: When pressing the key, the value in the corresponding register increases by one

value.
| BA Add Action [E= A
Action Type: =
String : I
Description:
4 2
Reference Mo.: I S
" Signed ' Unsigned
Max. @ I
Min. : I Step Size. : I
" OK I x Cancell
D String: Title of the corresponding action.

Description: Hint of this action.

Reference Number:
16-bit (R, D) or 32-bit (DR, DD).
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Maximum:
Minimum:
Signed:

Step Size:

Maximum value. No limit when blank.

Minimum value. No limit when blank.

When the item is checked, values from the register are unsigned;
otherwise signed.

The number of values increases every time this button is pressed.

8. Step Down: When pressing the key, the value inthe corresponding regigr decreases by

one value.
[ B& Add Action [E=EE)
Action Type: =
String : I
Description:
4 2
Reference Mo.: I Sign
" Signed & Unsigned
Max. @ I
Min. : I Step Size. : I
' 0K I x Cancell
RS String: Title of the corresponding action.
Description: Hint of this action.

Reference Number:
Maximum:
Minimum:

Signed:

Step Size:

The reference number corresponding to the PLC register, either
16-bit (R, D) or 32-bit (DR, DD).

Maximum value. No limit when blank.

Minimum value. No limit when blank.

When the item is checked, values from the register are either
unsigned or signed.

The number of values decreases eery time this button is pressed.
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In this example, the action type of the Swith Control is alternate, meaning pressing the
button for the first time is On and second time Off as shown below.

EA rePD BT s

File Edit Project Tools Options Help

D -d| P T RERR EERSAE Y XKL+ TP 8 |

—Project

& Device Info.
=-E Main Menu
EE Temperature Settings

=

i -#% Set Action's example
ST ST TSI
i Alarms

-l Startup Screen
—[Ed Screen Sawver

¢ Configuration

hModified | 1 2

B

3.2.4 List

The function of list is to represent the registercontent with a string or set the register
value(0-63) by chosen a string. Based on the aboveexample, we can illustrate this function
with the Size Adjustment function.

Step 1:  Select Size Adjustment on the screen. Then select [Edit?> [Add List] from the menu
bar, or right-click the item to call ou the pop-up menu and select [Add List].

Step 2: Input the requirements and settingsn the [Add List] window and press the
button to add the list. The example is as follows.

EA Add List -
String: Set List's example
Description: 1
4 [ 3
Reference No.: IRl [~ Read Only
Count: |3 'l
List String: Value |String |
0 Small
1 Middle
2 Big
" 0K I X cancel |
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Description:
Reference Number:

String: Title of the list.

Hint of the list.
The reference number corresponding to the PLC register.

Count: The total number of strings (2-64)to which the register corresponds.
Read-only: Value can be displayed but cannot be modified or set.
List String: Corresponding String refers to thedescription of the corresponding
item, and Value refers to thevalue of the corresponding item.

After completing the list, it will be addel to the Adjustment as shown below.

-
Ed PEPD

File Edit Project Tools Options Help
DS - e R R RSN SREY XKL T TR |

[ Project

EE Main

= Set List's example

+ § Device Info.

Menu

=-Ef Temperature Settings

----- O Alarms

- E& Startup Screen
- Screen Saver
----- sl Configuration

Modified |

[z [z

XY
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3.2.5 Find

In a complex and complicated project, users often need to spend much time finding a register
or string to modify it. With the [Find] function, users simgdy input the keyword and PEP
Designer will automatically search all regisers or strings containing the “keyword” and
display them in a list. The information also ircludes the location of tle matched registers or
strings; i.e. in which menu or function they are located. Therefog, it is very convenient. The
follow shows you how to use the Find function.

Step 1:  Select [Edit] 2[Find] with the mouse from the menu bar, or press the [Ctrl] + [F]
keys from the keyboard to call od the function as shown below.

i E# PEPD - C\Users\admin\Desktop\PEP Designer\sample pep =R NS
File | Edit |Project Tools Options Help

RGN SEBE Xk v+ e E

o [ 16 7 g

Th EA PEPD - C\Users\admin\Desktop\PEP Designer\sample pep l=[=1] = |
File Edit Project Tools Options Help

DS -] f B R S % @Gy XL v + TS E |

—Project

& Device Info. [ Sl
i |

B Main Menu EA Find .

& Alarms

Startup Screen Scope
Screen Saver &+ Reference Number
=} Configuration = String

Reference Mo. : ||

String = I

W OK I X cancel |

[o Y
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< Scope: Two options: Reference No. and String for users to choose.
Reference No.: Search contacts or registers irthe project, e.g. RO, X1, Y2.
String: Search strings in the project, e.g. Temperature, Switch.

Step 2:  After selecting the Scope and inputting theearch string in the String field, press

as shown below.
ER Find [E=RECR

—Scope
" Reference Mumber
% String

String : IIightI

W OK I x Cancell

The matched items, registers or strings containing the keyword will be displayed in the list
below the window, including their locations as shown below.

B PEPD - C\Users\admin',DesktopPEP Designerisample.pep o ]
File Edit Project Tools Options Help

DS - sl R RGN SAE Y XKL v+ TP |
Project
& Device Info.
s Main Menu
i Alarms

i Startup Screen
Screen Sawver
%8 Configuration

0  The lights Control

0.0  The room light

0.0.1 Turn on the light

0.1 The bathroom light
0.1.0 Turn on the light
Total 5 search result(s) found

| 1o | A

$¢ Right-click list and two options will pop up: Clear Search Results and Close Window.
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Step 3: Select a matched item in the list with th mouse to show the details of the item'’s
location as shown below.
i E#A PEPD - Ch\Users\admin\Desktop\PEP Designerisample.pep lElﬁlg
File Edit Project Tools Options Help
DS -]t e EGR SBEHY XKL + 5P |

—Project

& Device Info.

B- E Main Menu

=-Ef The lights Control
EI E The room light

Startup Screen
----- Screen Sawver
----- “i Configuration

The lights Control

0.1.0 Turn on the light
Total 5 search result(s) found

| | o I

p

% Double-click the item and the edit window of the selected item will pop up. Users can

directly edit or modify the contents as shown below.

[ Ef PEPD - Ch\Users\admin\Desktop\PEP Designenisample pep

= =] =& |

File Edit Project | ER tdit Action

:Eg

e

2 JIE.

e
- & Device Info.
=N E‘_ Main Menu
El EJ The lights C
. =-F The roo
- E‘_ Brigh 1
i Turn
E] The bath
I Ef The air-con
----- i Alarms
Z Startup Screen
1 Screen Saver
----- “i Configuration

0  The lights Control

0.0 on o

0.1.0  Turn on ﬂ"IE Ilght
Total 5 search result{s) fou

Action Type:

String (OM):

String (OFF) :

Description:

Reference Mo.:

IToggIe State

urn on the light

=

ITurn off the light

Y0

W 0K I x Cancell

e

[0 y

3.3

Project

Select [Project] from the menu bar. The [Prgect Menu] will pop up. Options in the Project
Menu include [Compile Menu], [Off-line Simulation], and [On-line Simulation] as shown
below.
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E# PEPD - C\Users\admin\\Desktop\PEP Designerisample.pep E=R[CI
File Editl Project Tools Options Help

; r‘C:}cijfr—r:iTu!.:E..S-i-r.'nuI:alfic:m Eg TS BRy XL s TN ||

| B8 On-line Simulation  F10

= Startup Screen
i Screen Saver
L-%pd Configuration

Modified | o

3.3.1 Compile Menu

After editing a menu, compile the menu by selecting [Project?[Compile Menu] from the

menu bar, or clicking the .i icon on the toolbar, or pressing the function key [F8] to

directly launch to the compile menu furtéon. With the compilation function, the designed
menus are converted into task codes executable BBEP and the statistics of the used code size
are provided.

i B8 PEPD - C\Users\admin\Desktop\PEP Designerysample. pep == &= [}
File Edit Project Tools Options Help

DS -@ R ERE B S% SOy XKL+ + PS8 |

—Project

B Compile Result | B

| Code Size Usage: 3892 Bytes used [/ 131072 Bytes available

| Qutput file : C:\Users\admin\Desktop\FPEF Designer\sample.mda

I =

Modified | o [

A

.

$¢ The information in the window includes “Code Size Usage” and “Output File”.
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3.3.2 Off-Line Simulation

After creating the user menus,you may want to validate if tley are consistent with the
planning. You can use the Off-Line Simulation. Select [Project]2> [Off-Line Simulation] with

the mouse from the menu bar, or click on the E icon on the toolbar,or press the function

key [F9] to launch the function. After verifying the compilation, press the button to

call out the simulation screen as shown below.

rﬂ PEPD - Ch\UsersyadminyDesktop\PEP Designer\sample.pep |.g.|1
File Edit Project Tools Options Help
O ~-d B %% it HEFea5
Project
- § Device Info. . -
: Simulation Screen @

=-Ef Main Menu
Alarms

g Startup Screen
: Screen Saver
.4l Configuration

Modified [+]

3.3.3 On-Line Simulation

Similar to the [off-line simulation] which runs the simulation on the PC, the only difference
between the offline and online simulation is &t the former does not connect to the PLC,
while the latter connects to the PLC viathe communication port on the PC running the
simulation. Select [Project]=>[On-Line Simulation] with the mouse from the menu bar, or

click on the E icon on the toolbar, or press the funtion key [F10] to launch the function.

After verifying the compilation, press the button. The Setup Port Parameter

window as shown below will pop up.
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r PEPD - CA\Usershadmin\Desktop\PEP Designer\sample.pep = = ]
File Edit Project Tools Options Help
ODE-d Ee " e by TEFe8 5
Project
é ai:;ciqinnfj" EH Setup Port Parameter = TR
Startup Sd Baud Rate: |EIH] -
i Screen Sawv Com Port: |COM4 ZI
“-=pd Configuratig
Start Exit
Modified [+]
P Baud Rate: The transfer baud rate betweenhe PC running the simulation and

the PLC.
Com Port: The PORT on the PC connecting to the PLC

After setting up the “Baud Rat” and “Com Port”, press the __sart_ | pytton. The On-line

Simulation screen like that of the [Off-line Simulation] will pop up as shown below.

-
PEPD - CA\Users\adminyDesktop\PEP Designer\sample.pep

File Edit Project Tools Options Help
BeE - E
Project

& Device Info. "
: Bf Main Menu Simulation Screen I&'

Startup Screen
g Screen Saver
L=l Configuration

Maodified [

3.4 Tools

There are three tools in the [Tools] functon on the menu bar: [Download Menu Data],
[Download Firmware], and [CharacterMap Tool] as described below.
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EA PEPD - Ch\Users\admiolDeskionlPER Designansample pep

File Edit Projec  Tools Options Help
| @ e - @ [||/ImDownloadMenubata . El@ v X Tl ¢ + F w55 |
e— $= Download Firmware .

roject

% Device Info. 38 Character Map Tool

=il Main Menu

Startup Screen
-kl SCreen Saver
¢ Configuration

Modified | [o

3.4.1 Download Menu
After validating the menu desigrwith the simulation, you maynow download the design to
PEP. Before downloading design to PEP, you must switch PEP device to system menu mode.

Then, select [Tools] 2 [Download Menu Data] from thefunction menu as shown below.
= [ o) [

i Ef PEPD - Ch\Users\admin\Desktop\PEP Designensample pep
Ootigpne H
ME v X s PR H |

File Edit Project _Iggle

I B = | “ b V| Download Menu Data ...
“Project | :
38 Character Map Tool

- & Device Info.
=
Alarms
Startup Screen
Screen Sawver
L#pd Configuration

Modified | [o

The Download Menu windows as shown below will pop up.
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i E# PEPD - Ch\Users\admin\Desktop\PEP Designer\sample.pep [=[=] =R ]

File Edit Project Tools Options Help
D -t ek (B S %R SMEY XkiLs + Py H |

—Project

& Dewvice Infoy” =1
B Main Menu HEA Download Menu =2 | B
© slarms Baud Rate: [9600 |
= Startup Scri
Screen Saw Com Port: |CDM4 ZI

- «Ed Configuratie

File Name:

IC:\Users\admin\,Desktop\PEP Designer\sample.mda _I

Modified | [0 A

After setup the “Baud Rate” and “Com Port” settings and select the file name, press the

__sat_ | pytton to download design to PEP for real operations.

3.4.2 Download Firmware

When it is necessary to updatethe PEP firmware, select [Tools] >[Download Firmware] from

the menu bar as shown below.

i EA PEPD - Ch\Usershadmin\Desktop\PEP Designerisample. pep e e
File Edit Project | Tools | Options Help
D -& | M v X v+ F PR H |
H Download Firmware |

—Proje | |

T eteT e o

- & Device Info.
=]
> Alarms
Startup Screen
i Screen Saver
L9l Configuration

Modified | o )

The Download Firmware window will pop up.

Page50/ 81



=S

B# PEPD - C\Users\admin\Desktop\PEP Designer\sample.pep
File Edit Project Tools Options Help

DS~ B R ES% @Gy XL e + TP 58 |

—Project
- & Device Info.r
: B Main Menu ER Cownload Firmware [E=EGE

19600
Startup Scr e =~
Screen Sawvi Com Port: |COM4 |
%l Configuratic
File Name:

Modified | [or [

W

¢ File name: Select the OS file to be updated.
%€ Contact your dealer for details concerning firmware update.

3.4.3 Character Map

When it is necessary to display special charactes or symbols on PEP, input these characters
and symbols with the [Character Map Tool] as shown below.

Step 1:  Select [Tools] 2 [Character Map] with the moug from the menu bar as shown
below.

L= [ ) ||

i EA PEPD - Ch\Usersha d.minmi!sictcp\PEF' Designensample.pep
File Edit Project | Tools | Options Help
]D@‘EH %= Download Menu Data ... E-\/Xﬁn&*fﬁgﬁt%ﬁ! ||

Dyl oo sl Cipoooa oo

[ Project @

- § Device Info.

o=l Main Menu

Startup Screen
Screen Saver
-4 Configuration

Character Map Tool

Modified | o

The Character Map Program will be run and the following screen will be shown.
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88 Character Map —
Font Name : lTahoma Ll
Subset : iUserPreference Characters .LI
1
A
Clear |
b

Font Name: The name of font currently usedoy the PEP Designer (modifiable
from [Option]>[Preference Output Font] on the menu bar).

If this combo list is selected to“User Preference Characters”, then
all the collected characters or symbols commonly used by users
will be shown. User can directly jump to specific character subsets
by control this combo list.

Subset:

Select a font class from the pull-downmenu or search the required character or
symbol. Select the required character osymbol with the mouse and it will be
displayed on the blank field as shown below.

Step 2:

( 3 Character Map [E=RIERESC

Font Name : ITa”Oma LI
I Subset : ILetterhke Symbols j U+2105 I
% 1% |C [CIt %% £ D °Flg [® % H & & | =)
FINg L bW Ne g P @R ERER
oWzl lobish KAlsalel | |
& |F Ao %2037 | O00OOOOO
1) 01 00 O | 1 0 O O | 01O O T A8 14 (T
OO0k 5 % % %% % % |Ys|% % %)Y
LI V|V VIVIVI K X XX L c DM E
1|3 |3 v | | |vii il |ix | x = (| ] (e |d|m
TB|@ Op [O0|/0|0003d8|0|0|0| o
[ Ti=lll2 il I8 AN = |# === 3 C
N L I I L e ) el il L
N L Y e A ol L o O ol Gl
K L L . 0 L - O~ el il el A 4
bl A O B il el 0 [ 5§ O 0§
OOooooooooooOoo|d| =

|°C Clear

© 0 »
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% Press the _““™| button to remove incorrectly chosen or unwanted characters or

symbols from the field.
& The “Character Map” is an independent application that will not affect the
operations or editing tasks of PEP Designer.

% Press the @ button to exit “Character Map”.

Step 3: Lastly, press the a button to add the selected dnacters or symbols to “User

Preference Characters” as shown below.

38 Character Map ] S
Font Mame : ]Tahoma .;'
Subset :  |User Preference Characters -

T

i

U+2103

Clear |

o O -

Step 4:  If you want to use a selectedcharacter or symbol, click it with the mouse to copy it.
Then move to the place where you want tase it, press the right mouse button and
select “Paste” from the pop-up menu to pasti. You may also press [Ctrl] + [V] to
paste the selected chracter or symbol.
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3.5 Options

There are two options in [Options]: [Languagé and [Preference OutputFont] as described
below.

i E# PEPD - C\Users\admin\Desktop\PEP Designer\sample pep e e
File Edit Project Tools | Options Help
|3 -6 || ¢ By| ‘Language J I TEEY -2
— Preference Qutput Font .
roject
-~ § Device Info.

Rl Main Menu

> Alarms

tartup Screen
4 Screen Sawver

L9l Configuration

Modified | [0

3.5.1 Language

PEP Designer offers three language options: English, Traditional Chinese, and Simplified
Chinese. You can select any of them as shown below.

Step 1:  Select [Options]=>[Language] with the mouse from the menu bar as shown below.

i B PEPD - C\Users\ad min\Deslctcp\PEF' Designer\sample pep = s

File Edit Project Tools

]D@vaﬂasﬂl_m“sh wm =
| Preference Output Font. Chinese (Traditional)

Chinese (Simplified)

—Project
- & Device Info.

B Main Menu]

o Alarms

‘Tﬂ Configuration

Modified | [0 [

& The above screen is displayed in English.
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Step 2: Three language options will appear in the pop-up menu. You will not need to
re-start the PEP Designer after changing a language, and everything will be
displayed in the selected language.

I:> [ B PEPD - C\Usershadmin\DesktophPEP Designerysample.pep =
EB=F £RE == IR EBEE =B

DS -E s RTIEE B G%SBEy XKL+ + TPy 5 |
B

e e e
g SHARRETE

Modified | [0 [ P

#< The above screen is displayed in Traditional Chinese.

|:> 'ﬂ PEPD - C\Users\admin\Desktop\PEP Designer,22 FIz788 pep L=CCE
#MEF £E HE IE IR kB
-] s T RA BGHRSAE Y XL+ + X955 |
i ERHAIFEE
o HSIAE
Modified | o | 5
o

2% The above screen is displayed in Simplified Chinese.
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3.5.2 Preference OQutput Font

Select [Options]>[Preference Output Font] with the mouse from the menu bar to select the
font of the characters, numbers and sybols displayed on the PEP as shown below.

i EA PEPD - Ch\Usershadmin\DesktophPEP Designerisample pep e e
File Edit Project Tools | Options |Help
| D= -& || ¢ By p—tacouage i X Gt v + H PR H |
— | Preference Qutput Font ...
roject 1
-~ § Device Info.
= Main Menu|
> Alarms

Startup Screen
Screen Saver
-4 Configuration

Modified | o )
The [Preference Output Font] window will pop up.
i E# PEPD - Ch\Users\admin\Desktop\PEP Designer\sample.pep Iilﬂlir

File Edit Project Tools Options Help

DS - Rk (B ES%SBEY XL+ + e 5 |

—Project

EA setup Output Font
Output Font: I
" OK I X cancel |
Modified | [ A

Select the preferred font fronthe pull-down menu in the Outpufont field. There are many
choices.
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, HA Setup Output Font =HECIHL X

Output Font: |[FETTTe j

Tall Paul
Tempus Sans ITC

Terminal

Times New Roman

Traditional Arabic

Trebuchet MS

Tunga <

After selecting the desired font, press the__¥ | button. The font on the PEP will be

changed into the selected font. You can validatehis with the [Off-line Simulation] function as
shown below.

::> [ Simulation Screen &Jw

e

% The font in the above screen is Tahoma.

::> [ Simulation Screen [ﬁ1

®

1) Ll
*[The lights Control]
The air-con Con .

e

¢ The font in the above screen is Arial Black.
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3.6 Configuration

In addition to the main menu, you can configre PEP from Configuration. Items in the
Configuration include “Alarm Source Register”, “Base Password Register”, “Working Space
Register”, "Screen Saver”, “Password Protection Type”, and “Set Level #1 as Top Level”.
When configuring “Alarm Source” and “Base Password”, you must assign a register first.
Procedures of configurdion are described below.

Select Configuration on the screenith the mouse. Then select [Edit}> [Edit] from the menu
bar or right click the item and select [Edit] from the popup menu. You may also double click
Configuration as shown below.

E# PEPD - C\Users\admin\Desktop\PEP Designerisample pep [ ETH 5
File | Edit IF’roject Tools Options Help

R (B SMEY XL s Tl |

(BB

== B = B B

(8]
t

SCCTED

na
03

B¢ FH) i ;mnah

Find _. Ctrl+F

Modified | [0 |

The Configuration Window as shown below will pop up.

[ HEf PEPD - C\Users\adminyDesktop\PEP Designer\sample pep @IEILP
File Edit Project Tools Options Help

DE-E] B TaR EIRSBEYy XL + S Faa 5 |
—Project

-~ & Device Info.
Ef Main Menu

EA Configuration ==

Alarm Source register: ||
Startup Scr
: Screen Sa Base Password register: I
% Configurati

Working Space register: I

Screen Saver

activate time: IlD Minute(s)
Effect: INone vl

Password Protection Type: IRead 8 Write vl

[~ Set Level #1 as Top Level

Modified
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The following shows an example of a Configurdion. Features in the Configuration function
will be explained and described below. This is for your reference only.

Screen Saver

[ Ed configuration =)
Alarm Source register: |R5 (R5)
Base Password register: |R1EI (R10~R11)
Working Space register: |R2EI (R20~R29)

activate time: |10 Minute(s)

Effect:

|Shnw Calendarj

Password Protection Type:

|Read & Write j

¥ Set Level 1 as Top Level

X cancel

#¢ Alarm Source Register:

sk Base Password Register:

3% Working Space Register:

Set the address of the rgister storing conditions
activating alarms. It is a 16-bit register. As shown in
the example, the Alarm Source Register is R5, which
means R5 is the register where the key values
activating alarms are stored. When the values in R5
and the designed index & identical, the alarm
activates. When the field isblank, there is no alarm.

Set the address of the register storing the user and
supervisor passwords. Userscan store a password with
one word or two words. The above example uses one
word for storing passwords. Register R10 stores the
Operator Password and R11the supervisor password.
When the field is blank, there is no password
protection. However,
corresponding register is 0,it also means there is no
password. When the supervier password is set, you
must enter the correspondig password before you can
access the system operating menu. When using two
words to store passwords, set register to DR, e.g.
DR10.

when the value of the

The number of working register allocated for PEP
application is 10 registers. In the above example, the
register is R20, this means registers R20-29 are the
Working Space Registers. After setting the Working
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¢ Screen Saver:

$¢ Password Protection Type:

3% Set Level #1 as Top Level:

Space Registers, R20 will be used to store the path of
the last active screen before system powerdown, while
others are for future expansion. When the field is
blank, the last active scieen is not retentive.

In the example, when the system idles for 10 minutes,
the Show Calendar screen save will activate to protect
your screen. Please see 4.4 for details.

The policy has two options: “read/write protection”
and “write-only protection”.In read/write protection,
users will need to enter tlk correct password before
they can access the operating menu. In write-only
protection, users can access the operating menu, but
they need to enter the correct password in order to
operate the system or set values.

When this item is unchecked, if users press the

key for 2 seconds or longer when operating the PEP,
the system will immediately return to the menu on
Level 0, regardless of the level of the previous menu.
When this item is checked, the system will return to
Level 1. If users want to return to Level 0 with this

item checked, they must return to Level 1 first, and

press - for 2 seconds or longer to return to Level

0. This feature allows users to lock the menu at the top
level to Level 1 in order to provide multilingual
operations with this feature (by setting the language
menu at Level 0) and hide the menu function.
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4. Examples and PEP Screens

4.1 Alarms

PEP provides the alarm function. The alarm activaés when the value in the “Alarm Source
Register” is identical to the “Index”. At the same time, the corresponding alarm message of
the Index will pop up on the screen. The index includes 01-64, which means users can set 64
alarms. When the Index is “0”, this means thele is no alarm. The follow shows how to set an
alarm.

Step 1:  Select [File] > [New] with the mouse from the menu bar.
Step 2: Select [Configuration] on the screen with the mouse. Then select [EditP[Edit]

from the menu bar, or right click the iten and select [Edit] from the pop-up menu as
shown below.

| Ed FePD ] ol S|
File | Edit [Project Tools Options Help
ErE IR T R T A T -
Project
-~ § Device Info.
B main Menu
-4 Alarms
Startup Screen
[ SEE Sae
§~ﬁﬂﬁﬂﬁiﬂﬁﬂﬁﬂ'% Ctrl+x
B € t
=8
Pl
=3
R ctri+
B Add Me
123 Adc
2 A
" -
S
-
e |
T
- T
hodified | [ 2
-« I e Up
& | e O
£ 1mport e
= Exp er
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Step 3: Assign a register in the “Alarm Source Register” item from the pop-up window as
shown below.

Ed cConfiguration =5

Alarm Source register: |R5| (R5)

Base Password register: I

Working Space reqgister: I

Screen Saver

activate time: |1E| Minute(s)

Effect: |N|:rn& j

Password Protection Type: |Rean:l & Write j

[ Set Level #1 as Top Level

o

% In the above example, register RS is assigned to the Alarm Source Register, i.e. RS is
the register where the key values activating the alarm are stored. When the values in
RS are identical to the index that has associate setup, the alarm activates.

Step 4:  Select Alarm on the screen with the mouse. Then select [EditP [Add Alarm] from
the menu bar, or right click the item tacall out the pop-up menu and select [Add

Alarm] as shown below.

[ A rpen—y = EEH
File | Edit IProject Tools Options Help
DE-E] ¢ ek BEE3% SQE Y XKL+ EFegH |

[ Project
#~ i Device Info.

[pEn]

Losl Configy

it

o
1

._En ;&‘

ErrE— |

mModified || P

TREH € |73 X <
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The Add Alarm window as shown below will pop up.

(EA cerD (=1=] =& J]
File Edit Project Tools Options Help
D -]t ek BE53%SOHYy XKL+ EFegH |
Project
B o | B8 Add Alarm ===
: - F\Iarrrq
-E2 Startyf | Index: fo1 =l
i-Ed Scree : X
4 Config Linel: I
Reference No.: I
Line2: I
Reference No.: I
Line3: I
Reference No.: I
" OK I b4 Cancell
Modified | [0 [ |
RS Index : Users can set any number from 01-64. When the value in the

Line :

Reference No.:

Alarm Source Register in Configuration is identical with the
Alarm No., the alarm message of the corresponding Index will be
activated. Therefore, the maximum number of alarms is 64.

The PEP screen supports the displayof three lines of text at the
same time. Therefore, Line 1 represents the text on Line 1, Line 2
on Line 2, and Line 3 on Line 3. Users can input the alarm
message here. One variable is allowed in each string, and users can
indicate its position with the “A” symbol.

The PLC register number corresponds to the variable.

Step 5:  Set the “Index”, “Alarm Message”, and “Reference Number” in the [Add Alarm]
window as shown below.

Edit Alarm =5

Index:
Linel:

Reference Mo.: I

Line2: ICurrent is =~
Reference No.: IRE
Line3: |Mure than set ~

Reference No.: IR;;1

o =]

IHigh temperature !!

o DK I X Cancell

€ In Line 2, the “*” symbol marks the display location of R6 content; and in Line 3,

the same symbol marks the display location of R7 content.
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After setting the alarm, press the button and the alarm will be added to Alarm as

shown below.

-

EA FEPD | | S
File Edit Project Tools Options Help

BN ) S B B
Project

i Device Info.

4 Screen Sawver
Lo Configuration

Modified [1]

Step 6: Check the alarm configuration with [(h-line Simulation] as shown below.

[ Ed peeD = 2 ]
File Edit Project Tools Options Help
ERSR v " B 5
Project

-~ & Device Info.
~& Main Menu
= Alarms

o L4 Alarm - 01
Startup Screen
Screen Saver
..o¢d Configuration

Modified o

€ You can also check the alarm configuration with [Off-line Simulation]. When an

alarm is set, the E icon will appear on the [Off-line Simulation] screen. Click the

icon to select the “Index” for running “Alarm Trigger” as shown below.
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r -
Simulation Screen I&J

Simulation Screen

A Alarm Trigger

=T ]
[Alarm Test (Off-ine)] Alarm Number: |2 -

After selecting the desired “Index”, pres the OK button and the corresponding “Alarm
Message” will be displayed on the simulation screen as shown below.

F 3
Simulation Screen @

4.2 Password Protection

PEP provides a password protection function. Uers can set “Operator” and “supervisor”
passwords. When the “Operator Password” isset, users will need to enter the password
according to the settings in the Configuration lbere they are allowed to operate PEP. If the
“Supervisor Password” is set, users must ente the supervisor password before they can access
the System Functions. Both passwords can be storeth one word or two words (set register to
DR). When this field is blank, there is no password protection. Wherpassword protection is
enabled, but the value in theorresponding register is 0, nopassword is set. The following
shows how to set a one-word password.

Step 1:  Select [File] >[New] with the mouse from the menu bar.

Step 2: Select Configuration on the screerwith the mouse. Then select [Edit}> [Edit] from
the menu bar, or right click the itemand select [Edit] from the pop-up menu.
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Step 3:

In the Configuration Setup window, asign a register in the “Base Password
Register” and select the “PasswordProtection Type” as shown below.

[ @ perD =[=] = ]

File

Edit Project Tools Options Help

D@ -E s BTRERRIBER SAHY XML+ + TP |

—Project

- § Device Info.
B ™ain Menu

“ﬂ Configu ratid

Configuration

Alarms Alarm Source register: I
Startup Scre

¢l Screen Save I Base Password register: IRlD (R10~R11) I

Working Space register: I

Screen Sawver

activate time: IlD Minute(s)
Effect: INone vI

I Password Protection Type: Read B Write| vl

I Set Level #1 as Top Level

X cancel |

Modified |

|

e

€ In the above example, register R10 is assigned to the “Base Password Register”,
which means that users can set the Operator Password in R10 and the supervisor
password in R11. The “Password Protection Type” is Read/Write Protection, which
means that users are requested to enter the correct password before they can access
the operating menu.

Step 4:

Step 5:

Select Main Menu on the screen with a mouse. Then select [EditP? [Add Menu]
from the menu bar, or right click theitem and select [Add Menu] from the pop-up
menu. Now, create a menu called Set Password.

Select Set Password with themouse. Then select [Edit]2>[Add Value] from the
menu bar, or right click the item and skect [Add Value] from the pop-up menu.
Now, set the Operator Password format as show below.

Add Value =
String: Set User's Password
Description: P
4 2
Reference Mo.: Ing [ Signed
Max. |55535 Decimal Point: Ig vl
Min.
fol Unit: |
I Read Only
" OK I XK cancel I
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€ If you want to set the supervisor password, see the example below.

EA Add value =
I String: |set Manager's Password I
Description: -

< »
Reference Mo.: |R11 [ Signed

Max. |65535 Decimal Point: |0 -I
Min.
|D| Unit: |—

W 0K I x Cance-II

[~ Read Only

After setting the password values, press th button to add th value items under

the Set Password menu as shown below.
[ EA pepD [ R

File Edit Project Tools Options Help

D - s R B RRESRE Y XKL+ T SEH |
—Project
o~ & Device Info.

=8 =8 St Password
23 Set User's Password
~123 Set Manager's Password

&£ Startup Screen
-[2d Screen Saver
o Configuration

Modified | 1 [0

[\
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Step 6: Check password functions with [Online Simulation] as shown below.
[ Simulation Screen lﬁ‘ Simulation Screen ﬁ Simulation Screen e

After setting the passwords, shut down the siulation and re-start the [On-line Simulation].
Before entering the menu page, you will be recasted to enter the password. You must enter
the correct password in order to acas to the menu as shown below.

mmsE e |

Please Input Pa

00000

#¢ The main difference between the operator password and supervisor password is that
the former allows users to access the menus but not the system functions when the
supervisor password protection is enabled. In this case, users need to use the
supervisor password to access the system functions.

4.3 Startup Screen

With PEP Designer, users can design and plan the startup screen of PEP. As there is space for
up to 16 startup screens, users can design a snildive startupscreen. In the following example,
we will show you how it works with the registered trademark of FATEK Automation

Corporation.

Step 1: Images used in the startup screen must be stored in the computer.

FATEX AUTOMATON CORPDRASTION
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% PEP Designer supports images in BMP, ICO, EMF and WMF formats.
% Image size: 128 x 64.

Step 2: Select Startup Screen on the screen with the mouse. Then select [Editt[Add
Screen] from the menu bar, or right clickthe item and select [Add Screen] from the
pop-up menu as shown below.

(A P == =
File | Edit rroject Tools Options Help

D -t TR E SR SAH Y XKL + TP |
—Project

~~ & Device Info.
B M™ain Menu

Startup Screen 8 Ctrl+3
== Vel ]y Ctrl+C
Configuration | =
- .
- .
&
=N Ctrl+
T Ad
122 A
3 Ad
'ﬂ. A
IS Add Li
1
. Delet Del
T D Ctrl+Del
B De
hModified | [0.a ¢ |
— - -
=TIR1
ErE

The Add Screen window as shown below will pop up.
(A rero [=[=] = ]

File Edit Project Tools Options Help

D -t TR (B SR SBH XKL + 5Py |

—Project
.| Bl Add Screen | S|

Image:
Clear |

W OK I x Cancell

Modified | [© [ |
P Load Image: Select an image from the corputer for the startup screen
Inverse Image: Inverse the color of the selectedimage (black to white, white to
black)
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After loading the required image for the startup screen, press t button.
|:> [ EA Add screen [

Image:

FATEK

FARSEEFERID
FATER AITANATIE BORRRT|SH

W OK | X cancel |
¢ Effect after image inverse
|:> [ @ Add screen &5
e FATEK
FEESHEBERAT
TR ANTARATRE CORPTRSTIIN
Clear

" OK | x Cance-ll

The new startup screen ScreerD is added to the Startup Screen menu as shown below.

[ EA rePD [ = e
File Edit Project Tools Options Help
DE-H] ¢ wafek B53%SQHY XKL + FTFYeg 5 |
[ Project

-~ & Device Info.
BT Main Menu

Modified | o [

|

#< The “0” in Screen-0 represents the first startup screen. There is space for up to 16
startup screens.
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Step 3: Select Startup Screen on the screerwith the mouse. Then select [Edit}> [Edit] from
the menu bar, or right click the item ad select [Edit] from the pop-up menu as
shown below.

rn pﬁED E=rprel g
FiIeIEdit IProjec’c Tools Options Help
| Do -] 4 R BRIRE GRS XIkILS + P |
—Project
- § Device Info.
B M™ain Menu
[] ) ]
Startup Screen ESEeT: Chrl+3
= *='Hx Copy Ctrl+C
Screen Saver |m oo frar
L.sed Configuration = N
E, Past nder Chrl+W
EL o Menu .
122
=
‘IE., tion ..
= t...
& Acd Alarm .
a2 = -
[TV EE—— |
T Delete Leaf Ctrl+Del
B Delete Mode
Modified | [ #« mrowe Up )
T §-  [ove Down _
¥ Import Menu
Ef Export Menu .

The Startup Screen window as shown below will pop up.
[ Ed rerD l=[=1] = ]

File Edit Project Tools Options Help

B ¢ e B RIE SR SAEHY XL+ T T egH |

[ Project

é Eﬂ:rl'- EH Startup Screen =

—End Condition

" By Time or Keypad

—Action Time

Flip Time: Ilg x0.1 sec (5-100)
Cycle Count: IU 'I

' OK I x Cancell

Modified | o [

XY

e

%€ End Condition: In what conditions the startup screen will end.

By Time: The display of the startup sceen is controlled by time.
By Keypad: The display of the startup screenis controlled by key: press any
key to end the startup screen.
By Time or Keypad The display of the startup screenis controlled by time or key at
the same time.
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%€ Action Time: Set the time of startup screen activation.

Flip Time: The time of display of the startup screen page(5-100): 0.5 seconds
is the shortest, and 10 seconds is the longest.
Cycle Count: The repetition of startup screen, maximum 10 times.

The settings in the following example are: Screen Flip Time: 5 seconds, withoutrepetition.
When the flip time is up or the user presses ny key, the system will enter the main screen.
[ HA startup Screen i |

End Condition

" By Time

i By Keypad

I i+ By Time or Keypad I

Action Time

AL 50 x0.1 sec (5-100)
Cycle Count: _ -

W OK | X cancel ‘

After setting the conditbns and actions, press th button. You can check the

settings with [Off-line Simulation] as shown below.

Ed PePD == =& |
File Edit Project Tools Options Help
ERSR~ v s B B
Project
»+§ Device Info. r
‘. ex_ﬂce nro Simulation Screen lﬁ
Ef Main Menu
- Alarms
tartup Screen
& Screen - 0
Screen Saver
L.oEl Configuration FATEK
FARSEEDBEIS
FATCR AITARIATEIE C0RP T H
ESC
\,
Modified [v]
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€ If you want to design a small live startup screen, you can design more startup screens
(preferable with related images) and select the Flip Time and Cycle Count as shown

below.
'ﬂ PEFD 5 o e S

File Edit Project Tools Options Help

e -H ~ s B B
Project
- § Device Info.
B Main Menu

Startup Screen

creen -
Screen -
Screen -

WM

-
-5 Configuration

Modified o

After setting the conditions ad actions, check the settings with [Off-line Simulation] as

shown below.
Simulation Screen E@ Simulation Screen et ( Skmulation Screen i) Simulation Screen ot

#< If you want to enter the Main menu after running the startup screen once, set Cycle
Count to 0. If you want to run several time, you can set the Cycle Count according to
the desired times. The maximum is 10 Cycle Counts.

4.4 Screen Saver

The screen saver function of PEP Designer ddivers the following five effects: “None”,
“Dimout”, “Show Image”, “Show Calendar”, a nd “Blackout”. You can configure the idling
time of the system before adtating the screen saver.
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Step 1: Select “Screen Saver” on the screen with the mouse. Then select [Edit}>[Edit]
from the menu bar, or right click the iten and select [Edit] from the pop-up menu as
show below.

EA PEPD o o

File | Edit |Project Tools Options Help

| D~ 4 iy R EEG% S@HY Xk + Y mm |
—Project

¢ & Device Info.

+-Bf Main Menu

- Alarms

Ctrl+x
Ctrl+C
Ctrl+

o 74‘..7.”

M . - T

[~ E—— ]

e

Modified | e 2

el

=1

Er

The “Screen Saver” window as shown below will pop up.
S =[=] =

File Edit Project Tools Options Help

P -] f i RR(BEEN SBE XKL + FFP e |

—Project

i i
EA Screen saver | B

Image:

Inverse |
Clear |

o 0K | x Cancell

Modified | [0 [ |

h

D Load Image: Load the image for the screen saver from the computer.
Inverse Image: Inverse image colors (black to white and white to black). Set the
background to black to pslong the screen life.
Clear: Clear the selected image.
¢ To extent the screen life, please choice the black color as picture background as
possible.
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Step 2: Select “Configuration” on the screenwith the mouse. Then select [Edit}> [Edit]
from the menu bar, or right click the iten and select [Edit] from the pop-up menu as
shown below.

e e o i e S
File | Edit IProject Tools Options Help
el _ ._ _
Ersl liFE T T T TR EL L LT Y - T T
[ Project
- & Device Info.
B main mMenu
P Alarms
Startup Screen
B k1] Configuration e Ctrl+x
Bz Cop Ctrl+C
f-fi P
Py
= p
B P Crl+
A
123
-
i
=
-
== i
[ |
o
Modified | & |
—————— —
- v
-
=11
=)

The “Configuration” window as shown below will pop up.
(®d pepo l=1=] = J]

File Edit Project Tools Options Help

R R B SR SEBEY XKLy + g E
—Project
-~ & Device Info.
BT Main Menu

- Alarms Alarm Source register: I
Startup Scri
Femi SCreen Save Base Password register: I
L-5pd Configuratio
Working Space register: I

Screen saver

activate time: IlD Minute(s)

Effect:

HA Configuration

None -

Dimout
Show Image Write LI
Showr Calendar
Black Out

Password Prote

[ Set Level #1

X cancel |

Modified

Y

-

X Activate Time: Set the idling time before screen saver activation.
Effect: Select any of the following effecs: None, Dimout, Image, Time,
or Blackout.

In the following example, when the system idlefor one minute, the sceen saver will activate.
The present time will be displayed on the s@&en, and the background will be Dimout as
shown below. You may need to eker the password, if erabled, in order to end the screen saver
and return to the normal screen.
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Configuration =5

Alarm Source register: |

Base Password register: |

Waorking Space reqister: |

Screen Saver

activate time: |1 Minute(s)

Effect: Show Calendarjiieg

Password Protection Type: |Read B Write J

[ Set Level #1 as Top Level

After setting the time and effect, press th button. You can check the settings with

[Off-line Simulation] as shown below. When “None” is selectd, though no screen saver action
will be activated when the idlingime is up, you still need to enter the password, if enabled, to
re-enter the normal screen.

Ef PEPD [= El

File Edit Project Tools Options Help

BOeE~-H ~ s B B
Project
- & Device Info. . -
= . Simulation Screen lél

~Ef Main Menu
O alarms
Startup Screen
4 Screen Saver
L4 Configuration

Modified [v]
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4.5 BPEP

BPEP is a member of the PEP product family from Fatek. The following example shows the
BPEP simulation with the PEP Designer. The functions and screens of tle panel features are
described below.

0.1
The room light
»[ The bathroom light ]

%€ Screen description: Black background and white font as shown below.

The number “1.1” on the left top cornerepresents the current menu path.
Up arrow symbol B if appears means there are more menus above.
Down arrow symbol Wit appears means there are more menus below.

Right arrow symbol IZ: There is a hint for this item. Press the . key to view the hint.

Left arrow symbol El: When you are viewing the hint. Press the. key to exit.

IEEREMD

% Key description: There are six keys, including

as shown below.

: Press the key to return to the previousevel. Press for 1.5 seconds to go to the
top level. Press for 6 seconds togo to the system function menu.

: When selecting functions, press the kg to enter the selecéd function (or the

next level of the function). In functioncontrol, press the key to control the
selected function. In function setup, prss the key to begin setup. After inputting
data, press the key to confirm data.
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: When selecting functions, press the kg to move upward at the same level.

When inputting values, press the key tatep up the value by “+1”. When there
are the “+” and “~“signs in the value item, press the key to switch to and from

II+II and ll_.II
= : When selecting functions, press the keyto move downwards at the same level.

When inputting values, press the key tatep down the value by “-1”. When
there are the “+” and “-" signs in the vdue item, press the key to switch to and
from “+” and “-". When the selected digit of a value is 0, press the key
continuously to reset thentire value to zero.

- : When selecting functions, if the right arrow symboln appears on the right top

corner, this means there is a hint for ths item. Press the key to view the hint.
When inputting values, press the key tanove to the next digit on the right.

- : When viewing the hint, press the key tareturn to the respctive function menu.

When inputting values, press the key to mve to the next digit on the left. When
Set Level #1 as Top Level is set in the Configuration, you must return to Level 1
first and press the key continuouslyto return to the top level.
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5. FAQ

Q1:

Ans.

Q2:

Ans.

Q3:

Ans.

Q4:

Ans.

Qs:

Ans.

Qeo:

Ans.

How many levels of menus can be created in a project? How many functions
can be set in each level?

Users can create up to 6 levelsof menus in a project amd set up to 10 menus or
functions at each level. However, menuscan only be created independently or in
association with actions.Therefore, when you createa menu with actions, you
cannot create a menu with lists at the same level.

Why can’t I create a menu with actions and a menu with lists at the same
level?

This is because the nature of actions andnenus differs from that of the value and
list. In the former, you can put different itens in the same screen; in the latter, you
can only put one item in the screen. Therefa;, they cannot exist at the same level.

Can new menus or functions be added behind a value, action or list item?
No menus or functions can be added behd a value, action orlist item. You can
only add menus or functions behind a menu.

Under what circumstances will we use the Character Map tool?

When designing menus, you may need to ussome special charaders and symbols,
such as temperature units like’C and °F. In this case, you can use the Character
Map. First, search the required characters or symbols fom the Character Map. After
selecting them with the mouse, you campaste them to the designated fields by
pressing the hotkeys [Ctrl] + [V].

How many alarms can be set? How do I activate these alarms?

The Index ranges from 01-64, which meansyou can set up to 64 alarms. When the
value in the Alarm Source Register in Configuration is identical to the Index, the
alarm activates. At the same time, thecorresponding alarm message (same Index)
will be displayed on the screen.

When editing an alarm, the text of the alarm message is input in the String
field. Now, what does the Reference Number field mean?

In the Add Alarm window, both the String and Reference numbercan be edited. The
String is the text displayed in the alarm message. When an alarm event occurs, in
addition to the preset alarm text, users may need to know the cause, severity and
scope of the alarm event. In this case, you can enter the number of the
corresponding register in the Reference Numdy field. The position of display of the
current register value in the alarm messge can be marked with the “A” symbol.
This way, when an alarm event occurs, tle current register vdue will replace the
“A” symbol in the alarm message.
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Q7:

Ans.

Q8:

Ans.

Q9:

Ans.

Q10:

Ans.

How many startup screens can be created in a project?
You can create up to 16 startup screens for a project.

In Configuration, what is the difference if checking and un-checking the “Set
Level # 1 as Top Level” option when operating the PEP?
If the option is unchecked, when you press thé ESC key for 2 seconds or longer

while operating PEP, the system always returns to the menus at Level 0 (top),
regardless at what level you were at. If tle option is checked, the system will return
only to Level 1. When the item is checkedand you want to return to Level 0 when

operating PEP, you must first return to Level 1 and press the- key for 2

seconds or longer in order to return to Level 0. See 3.6 for details.

How can users enter the System Menu of PEP?

Press the s key for 6 seconds or longer at ay level to enterthe System Menu.

However, when the supervisor password is enabled, you will need to enter the
correct supervisor password in oder to enter the System Menu.

What should we do if PEP does not function properly as a result of download
menu failure?

First, turn off the power and press th A ESC key continuously (do not release it).

Then restart the system tago to the “System Mode”. Now, select [Erase Menu Flash]
to clear the menus previously loaded. Thn, select [Run User Prog.] to enter the
System Menu. You can load the user meu again to see if it works properly.
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